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Copyright © 2006 Parametric Technology Corporation. All Rights Reserved. 

User and training documentation from Parametric Technology Corporation and its subsidiary companies (PTC) is subject to the copyright laws of the 

United States and other countries and is provided under a license agreement that restricts copying, disclosure, and use of such documentation. PTC hereby 

grants to the licensed user the right to make copies in printed form of this documentation if provided on software media, but only for internal/personal use 

and in accordance with the license agreement under which the applicable software is licensed. Any copy made shall include the PTC copyright notice and 

any other proprietary notice provided by PTC. This documentation may not be disclosed, transferred, modified, or reduced to any form, including 

electronic media, or transmitted or made publicly available by any means without the prior written consent of PTC and no authorization is granted to 

make copies for such purposes. 

Information described herein is furnished for general information only, is subject to change without notice, and should not be construed as a warranty or 

commitment by PTC. PTC assumes no responsibility or liability for any errors or inaccuracies that may appear in this document. 

The software described in this document is provided under written license agreement, contains valuable trade secrets and proprietary information, and is 

protected by the copyright laws of the United States and other countries. It may not be copied or distributed in any form or medium, disclosed to third 

parties, or used in any manner not provided for in the software licenses agreement except with written prior approval from PTC. UNAUTHORIZED USE 

OF SOFTWARE OR ITS DOCUMENTATION CAN RESULT IN CIVIL DAMAGES AND CRIMINAL PROSECUTION. 
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PT/Products, Shaping Innovation, Simple � Powerful � Connected, The Way to Product First, and Windchill. 

Trademarks of Parametric Technology Corporation or a Subsidiary 

3DPAINT, Arbortext Editor, Arbortext Contributor, Arbortext Companion for MS Word®, Arbortext Advanced Print Publisher – Desktop, 

Arbortext Advanced Print Publisher – Enterprise, Arbortext Publishing Engine, Arbortext Dynamic Link Manager, Arbortext Styler, Arbortext Architect, 

Arbortext Digital Media Publisher, Arbortext Adapter to Documentum®, Arbortext Adapter to Oracle®, Associative Topology Bus, AutobuildZ, CDRS, 

CV, CVact, CVaec, CVdesign, CV-DORS, CVMAC, CVNC, CVToolmaker, Create � Collaborate � Control � Communicate, EDAcompare, EDAconduit, 

DataDoctor, DesignSuite, DIMENSION III, Distributed Services Manager, DIVISION, e/ENGINEER, eNC Explorer, Expert Framework, 

Expert MoldBase, Expert Toolmaker, FlexPDM, FlexPLM, Harmony, InterComm, InterComm Expert, InterComm EDAcompare, 
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Pro/LEGACY, Pro/LIBRARYACCESS, Pro/MESH, Pro/Model.View, Pro/MOLDESIGN, Pro/NC-ADVANCED, Pro/NC-CHECK, Pro/NC-MILL, 

Pro/NC-POST, Pro/NC-SHEETMETAL, Pro/NC-TURN, Pro/NC-WEDM, Pro/NC-Wire EDM, Pro/NETWORK ANIMATOR, Pro/NOTEBOOK, 

Pro/PDM, Pro/PHOTORENDER, Pro/PIPING, Pro/PLASTIC ADVISOR, Pro/PLOT, Pro/POWER DESIGN, Pro/PROCESS, Pro/REPORT, 

Pro/REVIEW, Pro/SCAN-TOOLS, Pro/SHEETMETAL, Pro/SURFACE, Pro/VERIFY, Pro/Web.Link, Pro/Web.Publish, Pro/WELDING, ProductView, 

PTC Precision, Routed Systems Designer, Shrinkwrap, The Product Development Company, Validation Manager, Warp, Wildfire, 

Windchill DynamicDesignLink, Windchill PartsLink, Windchill PDMLink, Windchill ProjectLink, and Windchill SupplyLink. 

Patents of Parametric Technology Corporation or a Subsidiary 

Registration numbers and issue dates follow. Additionally, equivalent patents may be issued or pending outside of the United States. Contact PTC for 

further information. GB2366639B   13-October-2004. GB2363208   25-August-2004. (EP/DE/GB)0812447   26-May-2004. GB2365567   10-March-

2004. (GB)2388003B   21-January-2004. 6,665,569 B1   16-December-2003. GB2353115   10-December-2003. 6,625,607 B1   23-September-2003. 

6,580,428 B1   17-June-2003. GB2354684B   02-July-2003. GB2384125   15-October-2003. GB2354096   12-November-2003. GB2354924   24-

September-2003. 6,608,623 B1   19-August-2003. GB2353376   05-November-2003. GB2354686   15-October-2003. 6,545,671 B1   08-April-2003. 

GB2354685B   18-June-2003. GB2354683B   04-June-2003. 6,608,623 B1   19-August-2003. 6,473,673 B1   29-October-2002. GB2354683B   04-June-

2003. 6,447,223 B1   10-Sept-2002. 6,308,144    23-October-2001. 5,680,523   21-October-1997. 5,838,331   17-November-1998. 4,956,771 11-

September-1990. 5,058,000   15-October-1991. 5,140,321   18-August-1992. 5,423,023   05-June-1990. 4,310,615   21-December-1998. 4,310,614   30-

April-1996. 4,310,614   22-April-1999. 5,297,053   22-March-1994. 5,513,316    30-April-1996. 5,689,711   18-November-1997. 5,506,950   09-April-
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October-1986. 

Third-Party Trademarks 

Adobe, Acrobat, Distiller, and the Acrobat logo are trademarks of Adobe Systems Incorporated. IBM, AIX, and Websphere are registered trademarks of 

IBM Corporation. Allegro, Cadence, and Concept are registered trademarks of Cadence Design Systems, Inc. Apple, Mac, Mac OS, Panther and Tiger are 

trademarks or registered trademarks of Apple Computer, Inc. AutoCAD and Autodesk Inventor are registered trademarks of Autodesk, Inc. Baan is a 

registered trademark of Baan Company. CADAM and CATIA are registered trademarks of Dassault Systemes. DataDirect Connect is a registered 

trademark of DataDirect Technologies. CYA, iArchive, HOTbackup, and Virtual StandBy are trademarks or registered trademarks of CYA Technologies, 

Inc. DOORS is a registered trademark of Telelogic AB. FLEXnet, InstallShield, and InstallAnywhere are trademarks or registered trademarks of 

Macrovision Corporation. Geomagic is a registered trademark of Raindrop Geomagic, Inc. EVERSYNC, GROOVE, GROOVEFEST, GROOVE.NET, 

GROOVE NETWORKS, iGROOVE, PEERWARE, and the interlocking circles logo are trademarks of Groove Networks, Inc. Helix is a trademark of 

Microcadam, Inc. HOOPS is a trademark of Tech Soft America, Inc. HP, Hewlett-Packard, and HP-UX are registered trademarks of Hewlett-Packard 

Company. Advanced ClusterProven, ClusterProven, the ClusterProven design, Rational Rose, and Rational ClearCase are trademarks or registered 

trademarks of International Business Machines in the United States and other countries and are used under license. IBM Corporation does not warrant and 

is not responsible for the operation of this software product. I-DEAS, Metaphase, Parasolid, SHERPA, Solid Edge, TeamCenter, UG-NX, and 

Unigraphics are trademarks or registered trademarks of UGS Corp. Intel is a registered trademark of Intel Corporation. IRIX is a registered trademark of 

Silicon Graphics, Inc. I-Run and ISOGEN are registered trademarks of Alias Ltd. LINUX is a registered trademark of Linus Torvalds. MainWin and 



  

Mainsoft are trademarks of Mainsoft Corporation. MatrixOne is a trademark of MatrixOne, Inc. Mentor Graphics and Board Station are registered 

trademarks and 3D Design, AMPLE, and Design Manager are trademarks of Mentor Graphics Corporation. MEDUSA and STHENO are trademarks of 

CAD Schroer GmbH. Microsoft, ActiveX, JScript, Windows, Windows NT, Windows 2000, Windows 2000 Server, Windows XP, 

Windows Server 2003, the Windows logo, Visual Basic, the Visual Basic logo, and Active Accessibility are trademarks or registered trademarks of 

Microsoft Corporation in the United States and/or other countries. Moldflow is a registered trademark of Moldflow Corporation. Netscape and the 

Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications Corporation in the U.S. and other countries. Oracle and 

interMedia are registered trademarks of Oracle Corporation. OrbixWeb is a registered trademark of IONA Technologies PLC. PDGS is a registered 

trademark of Ford Motor Company. RAND is a trademark of RAND Worldwide. RetrievalWare is a registered trademark of Convera Corporation. 

RosettaNet is a trademark and Partner Interface Process and PIP are registered trademarks of RosettaNet, a nonprofit organization. SAP and R/3 are 

registered trademarks of SAP AG Germany. SolidWorks is a registered trademark of SolidWorks Corporation. All SPARC trademarks are used under 

license and are trademarks or registered trademarks of SPARC International, Inc. in the United States and in other countries. Products bearing SPARC 

trademarks are based upon an architecture developed by Sun Microsystems, Inc. Sun, Sun Microsystems, the Sun logo, Solaris, UltraSPARC, Java and all 

Java based marks, and “The Network is the Computer” are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and in 

other countries. 3Dconnexion is a registered trademark of Logitech International S.A. TIBCO is a registered trademark and TIBCO ActiveEnterprise, 

TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Rendezvous, TIBCO TurboXML, and TIBCO BusinessWorks are trademarks or 

registered trademarks of TIBCO Software Inc. in the United States and other countries. WebEx is a trademark of WebEx Communications, Inc. 

API Tookit is a trademark of InterCAP Graphics Systems, Inc. BEA and WebLogic are registered trademarks of BEA Systems, Inc. 

BEA WebLogic Server and BEA WebLogic Platform are trademarks of BEA Systems, Inc. Compaq is a registered trademark of Compaq Computer 

Corporation. DEC is a registered trademark of Digital Equipment Corporation. Documentum and Documentum Administrator are trademarks of 

Documentum, Inc. Elan License Manager and Softlock are trademarks of Rainbow Technologies, Inc. JAWS is a registered trademark of Freedom 

Scientific BLV Group, LLC in the United States and other countries. FileNET is a registered trademark of FileNET Corporation. Panagon is a trademark 

of FileNET Corporation. Galaxy Application Environment is a licensed trademark of Visix Software, Inc. Interleaf is a trademark of Interleaf, Inc. 

IslandDraw and IslandPaint are trademarks of Island Graphics Corporation. Netscape, Netscape Navigator, and Netscape Communicator are registered 

trademarks and service marks of Netscape Communications Corporation. OSF/Motif and Motif are trademarks of the Open Software Foundation, Inc. 

Palm Computing, Palm OS, Graffiti, HotSync, and Palm Modem are registered trademarks, and Palm III, Palm IIIe, Palm IIIx, Palm V, Palm Vx, 

Palm VII, Palm, More connected, Simply Palm, the Palm Computing platform logo, all Palm logos, and HotSync logo are trademarks of Palm, Inc. or its 

subsidiaries. Proximity and Linguibase are registered trademarks of Proximity Technology, Inc. SPARC is a registered trademark and SPARCStation is a 

trademark of SPARC International, Inc. (products bearing the SPARC trademarks are based on an architecture developed by Sun Microsystems, Inc.). 

TeX is a trademark of the American Mathematical Society. UNIX is a registered trademark of The Open Group. X Window System is a trademark of X 

Consortium, Inc. 

Third-Party Technology Information 

Certain PTC software products contain licensed third-party technology: 

Rational Rose and Rational ClearCase are copyrighted software of IBM Corp. 

RetrievalWare is copyrighted software of Convera Corporation. 

VisTools library is copyrighted software of Visual Kinematics, Inc. (VKI) containing confidential trade secret information belonging to VKI. 

HOOPS graphics system is a proprietary software product of, and is copyrighted by, Tech Soft America, Inc. 

I-Run and ISOGEN are copyrighted software of Alias Ltd. 

Xdriver is copyrighted software of 3Dconnexion, Inc, a Logitech International S.A. company. 

G-POST is copyrighted software and a registered trademark of Intercim. 

VERICUT is copyrighted software and a registered trademark of CGTech. 

FLEXnet Publisher is copyrighted software of Macrovision Corporation. 

Pro/PLASTIC ADVISOR is powered by Moldflow technology. 

Fatigue Advisor nCode libraries from nCode International. 

TetMesh-GHS3D provided by Simulog Technologies, a business unit of Simulog S.A. 

MainWin Dedicated Libraries are copyrighted software of Mainsoft Corporation. 

DFORMD.DLL is copyrighted software from Compaq Computer Corporation and may not be distributed. 

LightWork Libraries are copyrighted by LightWork Design 1990–2001. 

Visual Basic for Applications and Internet Explorer is copyrighted software of Microsoft Corporation. 

Parasolid is © UGS Corp. 

TECHNOMATIX is copyrighted software and contains proprietary information of Technomatix Technologies Ltd. 

TIBCO ActiveEnterprise, TIBCO Designer, TIBCO Enterprise Message Service, TIBCO Rendezvous, TIBCO TurboXML, and TIBCO BusinessWorks 

are provided by TIBCO Software Inc. 

DataDirect Connect is copyrighted software of DataDirect Technologies. 

Technology "Powered by Groove" is provided by Groove Networks, Inc. 

Technology "Powered by WebEx" is provided by WebEx Communications, Inc. 

Oracle 8i run-time, Oracle 9i run-time, and Oracle 10g run-time are Copyright 2002–2004 Oracle Corporation. Oracle programs provided herein are 

subject to a restricted use license and can only be used in conjunction with the PTC software they are provided with. 

Adobe Acrobat Reader and Adobe Distiller are copyrighted software of Adobe Systems Inc. and are subject to the Adobe End-User License Agreement as 

provided by Adobe with those products. 

Certain license management is based on Elan License Manager © 1989-1999 Rainbow Technologies, Inc. All rights reserved. 



 

Portions compiled from Microsoft Developer Network Redistributable Sample Code, Copyright © 1998 by Microsoft Corporation. 

The CD-ROM Composer and CD-ROM Consumer are based on Vivace CD-Web Composer Integrator © 1996-1997 KnowledgeSet Corporation. All 

rights reserved. 

Larson CGM Engine 8.0, Copyright © 1992-2002 Larson Software Technology, Inc. All rights reserved. 

Certain graphics-handling portions are based on the following technologies:  

GIF: Copyright 1989, 1990 Kirk L. Johnson. The author disclaims all warranties with regard to this software, including all implied warranties of 

merchantability and fitness. In no event shall the author be liable for any special, indirect, or consequential damages or any damages whatsoever 

resulting from loss of use, data or profits, whether in an action of contract, negligence, or other tortious action, arising out of or in connection with the 

use or performance of this software.  

JPEG: This software is based in part on the work of the Independent JPEG Group.  

PNG: Copyright 2000, 2001 Glenn Randers-Pehrson. 

TIFF: Copyright 1988-1997 Sam Leffler, Copyright © 1991-1997 Silicon Graphics, Inc. The software is provided AS IS and without warranty of any 

kind, express, implied, or otherwise, including without limitation, any warranty of merchantability or fitness for a particular purpose. In no event shall 

Sam Leffler or Silicon Graphics be liable for any special, incidental, indirect, or consequential damages of any kind, or any damages whatsoever 

resulting from loss of use, data or profits, whether or not advised of the possibility of damage, or on any theory of liability, arising out of or in 

connection with the use or performance of this software.  

XBM, Sun Raster, and Sun Icon: Copyright,1987, Massachusetts Institute of Technology.  

ZLIB: Copyright 1995-1998 Jean-loup Gailly and Mark Adler.  

PDFlib software is copyright © 1997-2003 PDFlib GmbH. All rights reserved.  

PStill software is copyright © Dipl.- Ing. Frank Siegert, 1996-2004 

Proximity Linguistic Technology provides spelling portions of certain software products: The Proximity/Bertelsmann Lexikon Verlag Database. 

Copyright © 1997 Bertelsmann Lexikon Verlag. Copyright © 1997, All Rights Reserved, Proximity Technology, Inc.; The Proximity/C.A. Strombertg 

AB Database. Copyright © 1989 C.A. Strombertg AB. Copyright © 1989, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Editions 

Fernand Nathan Database. Copyright © 1984 Editions Fernand Nathan. Copyright © 1989, All Rights Reserved, Proximity Technology, Inc.; The 

Proximity/Espasa-Calpe Database. Copyright © 1990 Espasa-Calpe. Copyright © 1990, All Rights Reserved, Proximity Technology, Inc.; The 

Proximity/Dr. Lluis de Yzaguirre i Maura Database. Copyright © 1991 Dr. Lluis de Yzaguirre i Maura Copyright © 1991, All Rights Reserved, Proximity 

Technology, Inc.; The Proximity/Franklin Electronic Publishers, Inc. Database. Copyright © 1994 Franklin Electronic Publishers, Inc. Copyright ©  

1994, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Hachette Database. Copyright © 1992 Hachette. Copyright © 1992, All Rights 

Reserved, Proximity Technology, Inc.; The Proximity/IDE a.s. Database. Copyright © 1989, 1990 IDE a.s. Copyright © 1989, 1990, All Rights Reserved, 

Proximity Technology, Inc.; The Proximity/Merriam-Webster, Inc. Database. Copyright © 1984, 1990 Merriam-Webster, Inc. Copyright © 1984, 1990, 

All Rights Reserved, Proximity Technology, Inc.; The Proximity/Merriam-Webster, Inc./Franklin Electronic Publishers, Inc. Database. Copyright © 1990 

Merriam-Webster Inc. Copyright © 1994 Franklin Electronic Publishers, Inc. Copyright © 1994, All Rights Reserved, Proximity Technology, Inc.; The 

Proximity/Munksgaard International Publishers Ltd. Database. Copyright © 1990 Munksgaard International Publishers Ltd. Copyright © 1990, All Rights 

Reserved, Proximity Technology, Inc.; The Proximity/S. Fischer Verlag Database. Copyright © 1983 S. Fischer Verlag. Copyright © 1997, All Rights 

Reserved, Proximity Technology, Inc.; The Proximity/Van Dale Lexicografie by Database. Copyright © 1995, 1997 Van Dale Lexicografie by. Copyright 

© 1996, 1997, All Rights Reserved, Proximity Technology, Inc.; The Proximity/William Collins Sons & Co. Ltd. Database. Copyright © 1984, 1990 

William Collins Sons & Co. Ltd. Copyright © 1988, 1990, All Rights Reserved, Proximity Technology, Inc.; The Proximity/Zanichelli Database. 

Copyright © 1989 Zanichelli. Copyright © 1989, All Rights Reserved, Proximity Technology, Inc.  

The Arbortext Import/Export feature includes components that are licensed and copyrighted by CambridgeDocs LLC (© 2002-2005 CambridgeDocs 

LLC). This functionality:  

Includes software developed by the Apache Software Foundation (http://www.apache.org/). 

Redistributes JRE 1.4.2_08 from Sun Microsystems. The Redistributable is complete and unmodified, and only bundled as part of the product. 

CambridgeDocs is not distributing additional software intended to supersede any component(s) of the Redistributable, nor has CambridgeDocs 

removed or altered any proprietary legends or notices contained in or on the Redistributable. CambridgeDocs is only distributing the Redistributable 

pursuant to a license agreement that protects Sun’s interests consistent with the terms contained in the Agreement. CambridgeDocs agrees to defend 

and indemnify Sun and its licensors from and against any damages, costs, liabilities, settlement amounts and/or expenses (including attorney’s fees) 

incurred in connection with any claim, lawsuit, or action by any third party that arises or results from the use or distribution of any and all Programs 

and/or Software. This product includes code licensed from RSA Security, Inc. Some portions licensed from IBM are available at 

http://oss.software.ibm.com/icu4j/. 

Redistributes the Saxon XSLT Processor from Michael Kay, more information, including source code is available at http://saxon.sourceforge.net/. 

Uses cxImage, an open source image conversion library that follows the zlib license. cxImage further uses the following images libraries which also 

ship (statically linked) with cxLib: zLib, LibTIFF, LibPNG, LibJPEG, JBIG-Kit, JasPer, LibJ2K. See http://www.xdp.it/cximage.htm.  

Includes software developed by Andy Clark, namely Neko DTD. NekoDTD is © Copyright 2002, 2003, Andy Clark. All rights reserved. For more 

information, visit http://www.apache.org/~andyc/neko/doc/index.html. 

Includes code which was developed and copyright by Steven John Metsker, and shipped with Building Parsers with Java, from Addison Wesley. 

Uses controls from Infragistics NetAdvantage 2004, Volume 3, © Copyright 2004 Infragistics. 

Word, FrameMaker, and Interleaf filters. Copyright © 2000 Blueberry Software. All rights reserved. 

Portions of software documentation are used with the permission of the World Wide Web Consortium. Copyright © 1994–2004 World Wide Web 

Consortium, (Massachusetts Institute of Technology, European Research Consortium for Informatics and Mathematics, Keio University). All Rights 

Reserved. http://www.w3.org/Consortium/Legal/. Such portions are indicated at their points of use. 



  

Copyright and ownership of certain software components is with YARD SOFTWARE SYSTEMS LIMITED, unauthorized use and copying of which is 

hereby prohibited. YARD SOFTWARE SYSTEMS LIMITED 1987. (Lic. #YSS:SC:9107001)  

********** 

METIS, developed by George Karypis and Vipin Kumar at the University of Minnesota, can be researched at http://www.cs.umn.edu/~karypis/metis. 

METIS is © 1997 Regents of the University of Minnesota. 

Certain software components licensed in connection with the Apache Software Foundation, all rights reserved, and use is subject to the terms and 

limitations at http://www.apache.org/. Apache software is provided by its Contributors AS IS, WITHOUT WARRANTIES OR CONDITIONS OF ANY 

KIND, and any expressed or implied warranties, including, but not limited to, the implied warranties of title non-infringement, merchantability and fitness 

for a particular purpose are disclaimed. In no event shall the Apache Software Foundation or its Contributors be liable for any direct, indirect, incidental, 

special, exemplary, or consequential damages (including, but not limited to, procurement of substitute goods or services; loss of use, data, or profits; or 

business interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort (including negligence or otherwise) arising 

in any way out of the use of this software, even if advised of the possibility of such damage. Apache software includes: 

Apache Server, Tomcat, Xalan, Xerces, and Jakarta, Jarkarta POI, Jakarta Regulat Expression, Commons-FileUpload  

IBM XML Parser for Java Edition, the IBM SaxParser and the IBM Lotus XSL Edition 

DITA-OT - Apache License Version 

Pop-up calendar components Copyright © 1998 Netscape Communications Corporation. All Rights Reserved. 

UnZip (© 1990-2001 Info-ZIP, All Rights Reserved) is provided AS IS and WITHOUT WARRANTY OF ANY KIND. For the complete Info-ZIP 

license see http://www.info-zip.org/doc/LICENSE. 

The Java™ Telnet Applet (StatusPeer.java, TelnetIO.java, TelnetWrapper.java, TimedOutException.java), Copyright © 1996, 97 Mattias L. Jugel, 

Marcus Meißner, is redistributed under the GNU General Public License. This license is from the original copyright holder and the Applet is provided 

WITHOUT WARRANTY OF ANY KIND. You may obtain a copy of the source code for the Applet at http://www.mud.de/se/jta (for a charge of no 

more than the cost of physically performing the source distribution), by sending e-mail to leo@mud.de or marcus@mud.de—you are allowed to choose 

either distribution method. Said source code is likewise provided under the GNU General Public License. 

GTK+ - The GIMP Toolkit is licensed under the GNU Library General Public License (LGPL). You may obtain a copy of the source code at 

http://www.gtk.org, which is likewise provided under the GNU LGPL. 

zlib software Copyright © 1995-2002 Jean-loup Gailly and Mark Adler. 

#ZipLib GNU software is developed for the Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA, copyright 

©1989, 1991. PTC hereby disclaims all copyright interest in the program #ZipLib written by Mike Krueger. #ZipLib licensed free of charge and there is 

no warranty for the program, to the extent permitted by applicable law. Except when otherwise stated in writing the copyright holders and/or other parties 

provide the program AS IS without warranty of any kind, either expressed or implied, including, but not limited to, the implied warranties of 

merchantability and fitness for a particular purpose. The entire risk as to the quality and performance of the program is with you. Should the program 

prove defective, you assume the cost of all necessary servicing, repair or correction. OmniORB is distributed under the terms and conditions of the GNU 

General Public License – The OmniORB Libraries are released under the GNU LGPL. 

The Java Getopt.jar file, copyright 1987-1997 Free Software Foundation, Inc. 

Java Port copyright 1998 by Aaron M. Renn (arenn@urbanophile.com), is redistributed under the GNU LGPL. You may obtain a copy of the source 

code at http://www.urbanophile.com/arenn/hacking/download.html. The source code is likewise provided under the GNU LGPL. 

CUP Parser Generator Copyright ©1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian–used by permission. The authors and their employers 

disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall the authors or their 

employers be liable for any special, indirect or consequential damages, or any damages whatsoever resulting from loss of use, data or profits, whether in 

an action of contract, negligence or other tortious action arising out of or in connection with the use or performance of this software. 

Software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org): Copyright © 1998-2003 The OpenSSL Project. 

All rights reserved. This product may include cryptographic software written by Eric Young (eay@cryptsoft.com). 

ImageMagick software is Copyright © 1999-2005 ImageMagick Studio LLC, a nonprofit organization dedicated to making software imaging solutions 

freely available. ImageMagick is freely available without charge and provided pursuant to the following license agreement: 

http://www.imagemagick.org/script/license.php. 

Mozilla Japanese localization components are subject to the Netscape Public License Version 1.1 (at http://www.mozilla.org/NPL). Software distributed 

under the Netscape Public License (NPL) is distributed on an AS IS basis, WITHOUT WARRANTY OF ANY KIND, either expressed or implied (see 

the NPL for the rights and limitations that are governing different languages). The Original Code is Mozilla Communicator client code, released March 

31, 1998 and the Initial Developer of the Original Code is Netscape Communications Corporation. Portions created by Netscape are Copyright © 1998 

Netscape Communications Corporation. All Rights Reserved. Contributors: Kazu Yamamoto (kazu@mozilla.gr.jp), Ryoichi Furukawa 

(furu@mozilla.gr.jp), Tsukasa Maruyama (mal@mozilla.gr.jp), Teiji Matsuba (matsuba@dream.com). 

The following components are subject to the Mozilla Public License Version 1.1 at http://www.mozilla.org/MPL (the MPL). Software distributed under 

the MPL is distributed on an AS IS basis, WITHOUT WARRANTY OF ANY KIND, either expressed or implied and all warranty, support, indemnity or 

liability obligations under PTC’s software license agreements are provided by PTC. See the MPL for the specific language governing rights and 

limitations. Modifications to Mesilla source code are available under the MPL and are available upon request: Gecko and Mesilla components; text 

(www.lowagie.com/iText/). iCal4j is Copyright © 2005, Ben Fortuna, All rights reserved. Redistribution and use of iCal4j in source and binary forms, 

with or without modification, are permitted provided that the following conditions are met: (i) Redistributions of source code must retain the above 

copyright notice, this list of conditions, and the following disclaimer; (ii) Redistributions in binary form must reproduce the above copyright notice, this 

list of conditions, and the following disclaimer in the documentation and/or other materials provided with the distribution; and (iii) Neither the name of 

Ben Fortuna nor the names of any other contributors may be used to endorse or promote products derived from this software without specific prior written 

permission. iCal4j SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS AS IS AND ANY EXPRESS OR 

IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 

http://www.mozilla.org/MPL


 

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 

CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 

OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGE. 

The Independent JPEG Group's JPEG software. This software is Copyright © 1991-1998, Thomas G. Lane. All Rights Reserved. This software is based 

in part on the work of the Independent JPEG Group. 

libpng, Copyright © 2004 Glenn Randers-Pehrson, which is distributed according to the disclaimer and license (as well as the list of Contributing 

Authors) at http://www.libpng.org/pub/png/src/libpng-LICENSE.txt. 

Curl software, Copyright ©1996 - 2005, Daniel Stenberg, <daniel@haxx.se>. All rights reserved. Permission to use, copy, modify, and distribute this 

software for any purpose with or without fee is hereby granted, provided that the above copyright notice and this permission notice appear in all copies. 

THE SOFTWARE IS PROVIDED AS IS, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED 

TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 

RIGHTS. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 

LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE 

SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not 

be used in advertising or otherwise to promote the sale, use, or other dealings. 

The cad2eda program utilizes wxWidgets (formerly wxWindows) libraries for its cross-platform UI API, which is licensed under the wxWindows Library 

License at http://www.wxwindows.org/. 

LAPACK libraries used are freely available at www.netlib.org (authors are Anderson, E. and Bai, Z. and Bischof, C. and Blackford, S. and Demmel, J. 

and Dongarra, J. and Du Croz, J. and Greenbaum, A. and Hammarling, S. and McKenney, A. and Sorensen, D.). 

The following software, which is provided with and called by certain PTC software products, is licensed under the GNU General Public License: Ghost 

Script (www.cs.wisc.edu/~ghost/); The PJA (Pure Java AWT) Toolkit library (www.eteks.com/pja/en/). 

JFreeChart is licensed under the GNU LGPL and can be found at www.jfree.org. 

Java Advanced Imaging (JAI) is provided pursuant to the Sun Java Distribution License (JDL) at www.jai.dev.java.net/. The terms of the JDL shall 

supersede any other licensing terms for PTC software with respect to JAI components. 

UNITED STATES GOVERNMENT RESTRICTED RIGHTS LEGEND 

This document and the software described herein are Commercial Computer Documentation and Software, pursuant to FAR 12.212(a)-(b) (OCT’95) or 

DFARS 227.7202-1(a) and 227.7202-3(a) (JUN’95), and are provided to the US Government under a limited commercial license only. For procurements 

predating the above clauses, use, duplication, or disclosure by the Government is subject to the restrictions set forth in subparagraph (c)(1)(ii) of the 

Rights in Technical Data and Computer Software Clause at DFARS 252.227-7013 (OCT’88) or Commercial Computer Software-Restricted Rights at 

FAR 52.227-19(c)(1)-(2) (JUN’87), as applicable. 010106 

Parametric Technology Corporation, 140 Kendrick Street, Needham, MA 02494 USA 
 

http://www.netlib.org/
http://www.jai.dev.java.net/
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1  
Installing and Setting Up 

the Schools Edition 

This Pro/ENGINEER Schools Edition guide provides instructions on the installation, 
implementation, and use of the Pro/ENGINEER Wildfire 3.0 software for teachers and 
students. This guide is subject to change without notice and without any commitment 
by Parametric Technology Corporation (PTC).  
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Overview of Pro/ENGINEER Schools Edition 
Welcome to the Pro/ENGINEER Wildfire 3.0 Schools Edition. PTC hopes that you 
enjoy using the world’s most popular 3D MCAD solution. This guide provides 
instructions on the installation, implementation, and use of the software. The Schools 
Edition Package includes the following items: 

• Pro/ENGINEER Schools Edition software on one CD-ROM.  

• Online Help for English, also on the CD-ROM. Other languages are available 
during an optional setup.  

• Pro/ENGINEER tutorials on the Pro/ENGINEER landing page. 

Usage Guidelines for Schools Edition Software 
Pro/ENGINEER Schools Edition is available to schools in the PTC Design & 
Technology in Schools Program. PTC does not offer installation and troubleshooting 
support. See http://www.ptc.com/for/education/troubleshooting_faq.htm for a FAQ of 
common questions. Alternatively, students can ask their teacher for assistance. If you 
experience problems during installation, see the Troubleshooting section. 

Note: You cannot use the Schools Edition software for commercial, professional, or for-
profit purposes. The software is not compatible with commercial versions of 
Pro/ENGINEER. 

Languages 
Choose from English, Chinese (Traditional and Simplified), French, German, Italian, 
Japanese, and Spanish for the Pro/ENGINEER Schools Edition. See the installation 
instructions for installing the desired language. 

File Compatibility of Pro/ENGINEER Editions 
The different editions of Pro/ENGINEER and the compatibility between them are 
shown in the next table.  

Pro/ENGINEER 
Edition 

Training  Schools  
Schools 
Advanced  

University 
Plus 

Student  Commercial  

Training   No No No No No 

Schools  No  Yes Yes Yes Yes* 

Schools 
Advanced  

No Yes  Yes Yes Yes* 

University Plus No Yes Yes  Yes Yes* 

Student  No Yes Yes Yes  Yes* 

Commercial  No Yes* Yes* Yes* Yes*  

* Requires the use of the Education-to-Commercial conversion tool, a part of University Plus. 

http://www.ptc.com/for/education/troubleshooting_faq.htm
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Features Specific to the Schools Edition 
Pro/ENGINEER Schools Edition is different from the commercial software in the 
following ways:  

• No access to floating options. 

• Schools Edition banners on the borders of plots and drawings. 

• Online registration and license generation process.  

• No running of software over a network. You must install the software on every 
computer using Pro/ENGINEER. 

• No software compatibility with commercial versions of Pro/ENGINEER. Objects 
created with the other Education Editions are compatible. 

Meeting Platform Requirements 
Before installing Pro/ENGINEER Schools Edition, your computer must meet the 
requirements in the next two tables. For platform details, see 
http://www.ptc.com/WCMS/files/30874/en/30874en_file1.pdf. 

Operating System Service Pack Processor 

Windows XP Professional and 
Home Edition, 32-bit 

Base OS, Service Pack 1 and 2 INTEL Pentium/Xeon family and 
AMD Opteron family 

Windows 2000, 32-bit Base OS, Service Pack 1,2,3 and 
4 

INTEL Pentium/Xeon family 

 

Minimum platform requirements follow. For computers upgraded from Windows 
95/98/Me to Windows 2000/XP, delete the winbootdir variable, otherwise 
Pro/ENGINEER fails to start.  

Platform Minimum Requirement 

Main Memory 256 MB (512 MB or higher) 

Available Disk Space 900 MB (Pro/E), 1.2 GB (with Pro/ENGINEER Mechanica) 

Swap Space 500 MB (1024 MB or higher) 

CPU Speed Pentium III 700 MHz (1 GHz or higher) 

Graphics Cards Cards must support OpenGL. For supported graphics cards, see 
http://www.ptc.com/WCMS/files/30874/en/30874en_file1.pdf. 

If your graphics card does not support OpenGL, see the section 
Configuring Graphics Acceleration. 

Browser Microsoft Internet Explorer 6.0 SP1 or later 

Network Microsoft TCP/IP, Ethernet network adapter 

Monitor 1024 X 768 (or higher) resolution with 24-bit or greater color 

http://www.ptc.com/WCMS/files/30874/en/30874en_file1.pdf
http://www.ptc.com/WCMS/files/30874/en/30874en_file1.pdf
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Platform Minimum Requirement 

File Systems NTFS 

Mouse Microsoft approved 3-button mouse 

Distribution Media CD-ROM or DVD drive 

Installing Pro/ENGINEER Schools Edition  
To perform the installation, use the Pro/ENGINEER Wildfire 3.0 Schools Edition CD. 
To streamline the process, first connect to the Internet and take the following actions 
first. Instructions follow in later sections. 

• Open a PTC online account, if you do not have one. 

• Generate a new software license.  

Logging In with Administrator Privileges 
To open the Pro/ENGINEER Schools Edition starting screen, follow these steps: 

1. Close all applications and disable your screen saver. Failure to do so can produce a 
poorly installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3. Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. If 
installation does not start, see the Troubleshooting section at the end of this guide. 
The Schools Edition starting screen appears.  
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4. Click the country flag to choose the language for the software installation. The 
Schools Edition information screen appears. 

 
 

 

You must have a PTC online account to generate a license. Create your online 
account now, if you have not already done so. 

Opening a PTC Online Account 
If you already have an online PTC account, skip to the next section.  

1. In the previous screen under Installation Instructions, click PTC online 
account in step 3. The New Account screen opens. 
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2. Fill in any empty text boxes. 

3. Click Create Account. A confirmation screen appears.  

4. Review and print this confirmation. A confirmation of your account is sent to your 
and your parent’s e-mail addresses.  

Generating a New License File 
The method of generating a license file depends on whether the computer on which 
Pro/ENGINEER will run is connected to the Internet. From the Schools Edition 
information screen shown previously, follow these steps. 

• No Internet for installed software—Skip to the section Generate an Offline License 
File. 

• Internet connection for the installed software—Follow the next steps. 
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1. Click Install Now to begin the installation for Pro/ENGINEER Schools Edition. 
The PTC.Setup screen appears. 

Note: During installation, you can click Exit at any time to stop the process.  

 

Generate an Online License 
If the computer for Pro/ENGINEER installation is connected to the Internet, use online 
license generation:  

1. Click Pro/ENGINEER to install the Pro/ENGINEER Schools Edition software. 
The PTC.Setup screen for License Configuration appears. 
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2. Click Generate License File. A prompt appears. 

3. Log in with your user name and password. PTC.Setup uses your PTC HOST ID 
and Schools Edition ID to generate the license file. The path appears in the 
License File Path box. 

4. Click Next. The Define Installation Components screen appears.  

Note: Now skip to the section Selecting the Pro/ENGINEER Modules to Install. 

Generate an Offline License  
If the computer on which Pro/ENGINEER is to be installed is not connected to the 
Internet, use offline license generation. Perform these steps on a computer connected to 
the Internet. You must then move the license to the computer on which the software 
will be installed. 

1. Click Generate License for Offline Mode at the bottom of the Schools Edition 
information screen shown previously. A prompt appears.  

2. Log in with your user name and password. The Pro/ENGINEER Schools 
Edition Licensing screen opens. Most of the text boxes are filled, except for the 
HostID.  
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3. In the HostID textbox, type the Host ID for the computer on which the Schools 
Edition will be installed.  

Note: For more information on your Host ID, see the Troubleshooting section. 

 

4. Click Submit Request. A confirmation screen appears. 

5. Review the information before closing your browser. 

Continue with the next two sections to save you License Pack. Then you can install the 
Schools Edition on your offline computer. 

Saving Your License Pack for Offline Use of Pro/ENGINEER 

Your License Pack for offline use arrives by e-mail within 2 hours. It contains a file 
attachment named sw_license_email_0000.dat or something similar. Save the file 
to the offline computer in an easily remembered location, for example, C:\TEMP.  

Caution: Do not edit the name or contents of this license file. Changes to it make the 
license invalid and prevents Pro/ENGINEER Schools Edition from starting. 
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Installing Pro/ENGINEER Schools Edition on the Offline Computer 

To open the Pro/ENGINEER Schools Edition starting screen, follow these steps: 

1. Close all applications and disable your screen saver. Failure to do so can produce a 
poorly installed application  

2. Log in as administrator or log on to an account with administrator privileges. 

3.  Insert the Pro/ENGINEER Schools Edition CD into your CD-ROM drive. If 
installation does not start, see the Troubleshooting section at the end of this guide. 
The Schools Edition starting screen appears. 

4. On the Schools Edition starting screen, click the language flag for the desired 
language. The School Edition information screen appears. 

5. Click Install Now. 

6. Click Pro/ENGINEER to install the Pro/ENGINEER Schools Edition software. 
The PTC.Setup screen for License Configuration appears. 

 

7. Click the Folder icon to the right of the License File Path box. 
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8. Navigate to the directory with your Pro/ENGINEER Schools Edition license file as 
shown in the Select File dialog box. The directory (Folder) path depends on where 
you saved your license file. It may not appear exactly as in the example. 

 

9. Select the license file and then click Open. The Select File dialog box closes the 
path appears in the License File Path box on the PTC.Setup screen for License 
Configuration. 

Note: To be prepared for a reinstallation, write down in a safe place the path of the 
license file. PTC strongly recommends this action.  

10. Click Next. The Define Installation Components screen appears.  

Selecting the Pro/ENGINEER Modules to Install  
In the Define Installation Components screen, you can choose not to install some 
modules of Pro/ENGINEER.  

1. Right-click a module to omit it from the installation, and click do not install.  
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Destination Folder C:\Program Files\ProENGINEER Schools Edition. To 
change this default location, type another path, or click Browse to 
select another path.  

PTC strongly recommends a new installation. The path cannot be 
an existing PTC directory, or PTC.Setup assumes you are trying to 
update or reconfigure Pro/ENGINEER Schools Edition.  

Platforms The only platform available in Pro/ENGINEER Schools Edition is 
i486_nt. This option is the default. 

Languages Check any additional languages for installation. Additional 
language packs require more hard drive space. 

Pro/ENGINEER (default) Keep this component to install the files necessary to run the 
software for Pro/ENGINEER Schools Edition. 

 

2. When finished specifying the installation directory, click Next. The Windows 
Preferences screen appears. 
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Defining Windows Preferences 
1. In the Windows Preferences screen shown below, you define your Windows 

preferences.  

 

2. Select your Shortcut Locations. 

3. In the Startup Directory text box, type the full path for the location of the 
shortcuts. 

4. Under Windows Environment Preferences, choose to modify the system 
environment for all users or the current user. 

5.  Click Next. The Optional Configuration Steps screen appears. 
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Configuring the OLE Settings 
Use the OLE settings checkbox to configure Pro/ENGINEER Schools Edition as an 
OLE (Object Linking and Embedding) Server. With this setting, you can import 
Pro/ENGINEER files (parts, assemblies, and drawings) into Microsoft documents 
(Word, Excel, and PowerPoint). You cannot import Microsoft files into Pro/ENGINEER.  

If you choose not to use OLE settings, skip to the next section. 

The Optional Configuration Steps screen below is open from the last step in the 
previous section. Proceed with the configuration for OLE settings.  

 

1. Select the OLE settings check box to customize your installation. 

2. Click Install. The PTC OLE Server screen appears. You can fine-tune the 
options, although all of the default values work. 
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3. In the Startup directory text box, enter the full path to the Pro/ENGINEER 
directory. Typically, this is the Pro/ENGINEER working directory.  

4. From the Language list, choose your language if other than the given language. 

5. In the PTC OLE Server Configuration, enter the startup directory of the PTC 
OLE Server. The Microsoft application (PTC OLE Container) searches for PTC 
objects in this directory. 

6. In the Language text box for the server, keep the language or choose another. 

Completing Pro/ENGINEER Configuration and Installation 
You have almost completed the Pro/ENGINEER installation. To proceed, click one of 
the following commands: 

• Click Back to review information.  

• Click Install to continue installation. 

• Click Exit to stop the installation. 



1-16 Installation and Administration Guide 

 

When Pro/ENGINEER stops, click Exit. 

Congratulations! You can now use Pro/ENGINEER Wildfire 3.0 Schools Edition. 
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Configuring and Setting Up Pro/ENGINEER 
Pro/ENGINEER provides a highly customizable environment with configuration files 
to define system-specific and application-specific settings, such as required drafting 
standards and system color schemes. If a configuration option is in more than one 
configuration file, Pro/ENGINEER applies the most recently loaded or recently read 
setting. 

• Protected system configuration files—At startup, Pro/ENGINEER first reads 
in a protected system configuration file called config.sup. The configuration 
option settings in this file cannot be overwritten by the config.pro file of an 
individual user.  

• Configuration files—Next, Pro/ENGINEER searches for and reads in 
configuration files config.pro, config.win, and menu_def.pro from the 
following directories in the following order: 

– <loadpoint>/<filename>—Pro/ENGINEER installation directory. Your 
system administrator can put configuration files here to support school for 
Windows configuration settings, formats, and libraries. Users starting 
Pro/ENGINEER from this load point, use the values in this file. 

– Login directory—The home directory for your login ID. By placing your 
configuration files here, you can start Pro/ENGINEER from any directory. You 
do not need to a copy of the configuration files in each directory. 

– Startup directory—Your current or working directory when you start 
Pro/ENGINEER. 

• Local configuration files—Last to be read are config.pro, config.win, and 
menu_def.pro in your startup directory. Therefore, they override any conflicting 
configuration file option entries on your computer. 

Using config.sup and config.pro Files 
You can create and store custom configuration files in your working directory. These 
files can apply to specific projects or to individual user settings. 

Config.sup 
Config.sup is a protected system configuration file. Use this file to ensure that 
students cannot change configuration settings, such as specified templates, directory 
settings, and so forth. The system administrator sets configuration options in the 
config.sup file for school-wide use. Values in this file cannot be overridden by the 
config.pro file.  

Note: The config.sup file must be in the text directory in the Pro/ENGINEER load 
point. 

To ensure the config.sup is always correct and up-to-date, create a .bat file to start 
Pro/ENGINEER and copy the config.sup file to the local computer's text directory. 
An example of a .bat file is in the section Using Trail Files. 

Config.pro 
By default, Pro/ENGINEER uses a set of predefined config.pro settings. When you 
make modifications to the default settings, a config.pro file is created in 
C:\Program Files\proeWildfire 3.0\text\. An example config.pro file is in 
the pro_standards\config_files directory. 
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Creating Configuration Options 

To view, modify, or add config.pro settings, follow these instructions: 

1. On the main toolbar of Pro/ENGINEER, click Tools > Options. The Options 
dialog box opens. 

2. Clear the Show only options loaded from file check box. All options are 
available. 

3. Click one or more configuration options from the left column to apply them. 

4. Click Apply.  

5. Save a backup copy of this file to a secure backup directory or disk. 

Configuring Graphics Acceleration 

One entry in the config.pro is for graphics cards. The default is set as follows: 
use_software_opengl = yes, so that Pro/ENGINEER uses OpenGL software for 
graphics. Check http://www.ptc.com/WCMS/files/30874en_file1.pdf to see if you have a 
compatible graphics card. If you do, change the config.pro entry to from yes to no 
to use that graphics card. 

Configuring Pro/ENGINEER to Be Like Pro/DESKTOP  

You can change config.pro options and make Pro/ENGINEER similar to 
Pro/DESKTOP. Click Tools > Options and use the Configuration Properties dialog 
box. Change each default setting with an asterisk in the next table to its opposite. 

Config.pro Option Description Value 

sketcher_blended_background Controls whether to use the blended in 3D 
Sketcher. The option has no effect if the 
blended background is turned off. 

No*/Yes 

sketcher_starts_in_2d Defines initial model orientation in Sketcher. 
Yes–(2D orientation) Looking directly at 
section (sketching) plane. No–(Orientation 
unchanged) Sketch directly on the 3D part. 

No/Yes* 

sketcher_refit_after_dim_modify Refits section after dimension modification 
in 2D section or when creating the first 
feature. 

No/Yes* 

Setting the Config.pro Files 

• .dtl—By default Pro/ENGINEER sets the drafting standard to ASME / ANSI. To 
use another standard, add a setting into the config.pro file to point 
Pro/ENGINEER at the required standard. The config.pro option is 
drawing_setup. Country-specific files are provided for your convenience. 

– UK—BS8888.dtl in pro_standards\config_files  

– Australia—AS1100.dtl in pro_standards\config_files  

• tree.cfg—The tree.cfg file controls how information is displayed in the Model 
Tree. This file is in pro_standards\config_files. You can control the Model 
Tree display by inputting the config.pro option mdl_tree_cfg_file and pointing it at 
the particular tree.cfg in the pro_standards\config_files directory. 

http://www.ptc.com/WCMS/files/30874en_file1.pdf
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• syscol.scl—To change the color scheme for Pro/ENGINEER, click View > Display 
Settings > System Colors. The color scheme is saved in the syscol.scl file. An 
alternative syscol.scl file is in the pro_standards\config_files directory. 
To use this syscol file, add the configuration option system_colors_file into 
your config.pro file and point it at the required file. 

Note: You can use a sample syscol.scl file for making Pro/ENGINEER 
drawings with a white background like Pro/DESKTOP. To enable this color 
scheme, set the system_colors_file into your config.pro file and point it at 
the required file in the pro_standards\config_files directory. You must 
restart Pro/ENGINEER for the changes to take place. 

• config.win—The config.win file is a database file. It stores window 
configuration settings, such as toolbar visibility and Model Tree location. 

Using Trail Files 
Every session of Pro/ENGINEER creates a trail file. This file contains all user actions 
in that session of Pro/ENGINEER. Delete these trail files on a regular basis to free up 
disk space. By default these trail files are created in the Start in directory defined 
within the Pro/ENGINEER shortcut icon. To view or change this configuration option, 
right-click the Pro/ENGINEER icon and choose Properties. 

IMPORTANT: The best location of the trail file directory is on the hard drive of the 
local computer. Pro/ENGINEER records every command and option in the trail file. 
Using the trail file directory over the network causes high network traffic. 

• To assist with system management, consider setting up a dedicated directory for 
trail files in the config.pro. Then the teacher, student, or IT (Information 
Technology) Administrator can delete the contents of this directory on a regular 
basis. 

• To set the trail file directory, set the trail_dir configuration option in the 
config.pro file to the required directory. Use the full path, for example, 
D:\trail\proe_trail_files. 

For an automated approach, you can include a routine in Pro/ENGINEER startup to 
delete trail files. Create a batch file to do this: 

1. Click Start > All Programs > Accessories > Word Pad. 

2. Type the following commands: 

echo off.  
REM Batch file created to delete Pro/ENGINEER trail files and then start Pro/ENGINEER 
REM first set current working directory 
set CWD=%cd% 
echo. 
echo Removing Pro/ENGINEER Trail Files from your directory 
echo. 
cd /d "c:\pro-standards\trail_files" 
erase trail.txt.* 
cd "%cwd%" 
echo. 
echo Now starting Pro/ENGINEER Wildfire 3.0 Schools Edition 
echo. 
" C:\Program Files\ProENGINEER Schools Edition\bin\proe.exe" 

 

3. Click Save As. For the Save as type, choose Text Document and give the file a 
meaningful name, for example, proe_clean-trail_start.bat. 
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Setting Search Paths 
Pro/ENGINEER requires a list of directories in which to search for file types, such as 
parts or drawings. By default Pro/ENGINEER looks in the current working directory. 
If parts and assemblies are in other directories, you must list the path explicitly in the 
config.pro or the search_path.pro. If you want to use the search_path.pro 
configuration option, the path to search_path_file must be in the config.pro file. 

PTC recommends using the full path for all directories. For example; consider the 
directory structure in the next figure.  

 

 

The search path entries required in either the config.pro file or the 
search_path.pro file are as follows: 

E:\shared\pro_standards\part_libraries\Batteries 

E:\shared\pro_standards\part_libraries\Fasteners 

Note: All students must set their own working directory within Pro/ENGINEER to the 
specific project. Therefore, teachers need not add design project directories for 
students, such as Boat and Car, to the search path.  

Pro/ENGINEER does not search subfolders or subdirectories. Every folder or directory 
with Pro/ENGINEER files must be included in search_path.pro. Pro/ENGINEER 
searches for files in a specific order: 

• In session (files opened and then closed but not erased) 

• In the directory from which the file or assembly is specifically opened 

My Computer

C (local drive) D (local drive) E (network 
drive) 

User Profiles 

Student’s name 

My Documents 

Design  Projects 

Car Boat 

Car_assy.asm

Wheel.prt 

Axle.prt 

Boat_assy.asm 

Hull.prt 

Cabin.prt 

Mast.prt 

Shared 

pro_standards 

Fasteners Batteries 

AAA.prt 

AA.prt 

screw.prt 

nut.prt 

Washer.prt D.prt 

templates 

proe_trail_files 

Part_libraries hole_tables 

A0_format.frm

A3_format.frm

Solid_start_part_mm
t

start_assembly_mm.

ISO_coarse.hol

trail.txt.1 

trail.txt.2 

trail.txt.3 
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• In the defined working directory 

• In directories listed in the search_path.pro file 

To ensure you are always using the correct Pro/ENGINEER files, erase the files that 
are not displayed. See the section Erasing Pro/ENGINEER Files. 

Using Template Files 
Pro/ENGINEER uses a number of template files whenever you create a new part, 
assembly, or drawing. The default template files are in the template directory within 
the Pro/ENGINEER program directories. The default templates are all in Imperial 
units, for example, inlbs_part_solid.prt and e_drawing.drw. 

For metric versions of files, add the following configuration options into your 
config.pro file and set the entry to point at the required files. 

• template_designasm—Specifies the designated template assembly 

• template_drawing—Specifies the drawing used as the default drawing template 

• template_solidpart—Specifies the model used as the defaults part template 

Note: Please see the pro_standards section. 

To use customized templates, such as drawing formats, create a single shared directory 
for all the templates. See the suggested directory structure in the next section. PTC 
provides example metric start parts and ISO drawing formats under the 
pro_standards/templates directory. 

Developing a Directory Structure 
The default Pro/ENGINEER directory is C:\Program Files\ProENGINEER 
Schools Edition. All the default template files, such as start parts and Imperial 
drawing templates, are in ProENGINEER Schools Edition\templates. Default 
configuration settings do not require a config.pro file or anything else. However, if 
you make any modifications to the config.pro file, create the relevant configuration 
file in C:\Program Files\ProENGINEER Schools Edition\text. 

As an instructional aid, sample configuration files, start parts, drawing templates, and 
other files are under Program Files\ProENGINEER Schools 
Edition\pro_standards. 

For all student to have access to the same data, you can place the pro_standards 
directory on a network drive. Then, make the relevant settings of the configuration 
options in the config.pro file point at this network directory. 
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My Computer

C drive 

Program Files

Pro_standards

Fasteners Batteries 

aa_battery.prtt 

aaa.battery.prt 

ss_cap_screw.p
t

ss_hex_nut.prt

c_battery.prt 

templates part_libraries hole_tables 

a0_format.frm

a1_format.frm

solid_start_part_m
t

start_assembly_mm

iso_coarse.hol 

ProENGINEER

d_battery.prt 

a2_format.frm

a3_landscape.f

a4_landscape_format
f

a3_template.dr

a4_portrait_format.d

a4_portrait.fr

Sheetmetal_start_part_m
t

config_files material_database 

config.pro 

lay0001.pro 

Syscol.scl 

Bs8888.dtl 

trail_files 

Running Pro/DESKTOP and Pro/ENGINEER on the Same Computer 
Note: If you are using Pro/DESKTOP 8.0 Service Pack 2 (datecode 2005400 build 
1067), ignore this section. 

When you run both Pro/DESKTOP and Pro/ENGINEER on the same computer, you 
must reregister Pro/DESKTOP each time you run Pro/ENGINEER. To reregister 
Pro/DESKTOP, open a DOS window and type the following commands: 

C% cd \Program Files\PTC\ProDESKTOP 8.0\Program 
C% prod.exe \regserver 

Using Pro_Standards in Classrooms 
To help implement Pro/ENGINEER Wildfire Schools Edition, PTC works with teachers 
around the world to provide preconfiguration for easier deployment within the 
classroom. A preconfiguration directory called pro_standards is in the 
<loadpoint>\ProENGINEER Schools Edition\ directory.  
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Within the ProENGINEER Schools Edition directory are the following directories: 

config_files 
hole_sizes 
material_database 
part_libraries 
templates 
trail_files 

Copy the pro_standards directory to a centrally accessible drive or directory. All 
students can then access common templates, part libraries, configuration options, and 
so forth. The purpose of each directory, its contents, and how to use it follows. 

config_files  
Pro/ENGINEER Wildfire uses different files to configure how Pro/ENGINEER looks 
and functions. Typically a Pro/ENGINEER System Administrator with knowledge of 
configuration options sets up these files. To help teachers implement Pro/ENGINEER 
Wildfire Schools Edition, a preconfigured set of configuration files comes with the 
software. You can modify the preconfigured files as you become more familiar with 
Pro/ENGINEER's operation. 

config.pro 
One of the most important configuration files in Pro/ENGINEER is the config.pro 
file. This file must be on each computer under <loadpoint>\ProENGINEER Schools 
Edition\text\. The teacher or an IT (Information Technology) Administrator should 
modify the config.pro within Pro/ENGINEER to suit educational requirements. 
Save the file in a secure location, and copy it to each computer running 
Pro/ENGINEER. 

The config.pro file contains a list of directories that Pro/ENGINEER searches to find 
drawing formats, drafting standards, templates, and so forth. The teacher or IT 
Administrator must edit the relevant directory settings within the config.pro file. 
For example, the configuration option template_solidpart specifies which template 
file that Pro/ENGINEER uses for new parts. Provide the full path in the configuration 
options. 

Note: If you have moved the pro_standards directory to a centrally accessible drive 
or directory, modify this setting to point Pro/ENGINEER at the new location. 

To modify the config.pro file, follow these steps: 

1. Start Pro/ENGINEER. 

2. Click Tools > Options. 

3. Choose each option and modify its value.  

4. Click Add/Change after each change.  

5. Click Apply or OK. The newly modified config.pro file is saved for future use 

Note: You must copy the final config.pro file onto every computer running 
Pro/ENGINEER. Place it in the directory <loadpoint>\ProENGINEER Schools 
Edition\text\. 

search_path.pro 
The search_path.pro file specifies where Pro/ENGINEER searches for any parts, 
assembly files, and other files that are not in the working directory. In Word Pad or 
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Note Pad, you can edit the search_path.pro file. Use the full path for the 
configuration option. A search_path.pro file comes with the software. It contains the 
paths to sample parts, such as, pro_standards/part_libraries/fasteners. 

The location of the search_path.pro file is specified in the config.pro file. You 
must modify the path in this file to suit your own directory structure. 

bs8888. dtl  
Pro/ENGINEER does not come with a predefined UK BS8888 drafting standard. The 
bs8888.dtl file for the Schools Edition configures Pro/ENGINEER's drafting 
functions to replicate the BS8888 drafting standard. 

 iso.dtl 
A copy of the ISO drafting standard configuration file, iso.dtl, comes with 
Pro/ENGINEER Schools Edition. The installation of the Schools Edition copies it into 
the pro_standards directory. This location ensures that students are using the same 
iso.dtl file. 

lay0001.pro 
The lay0001.pro configuration file specifies on which layers to place specific entities 
such as datum planes. 

syscol.scl 
The syscol.scl configuration file defines the colors for use for different types of 
geometry, graphics, text, and so forth, in Pro/ENGINEER. 

tree.cfg 
The tree.cfg configuration file determines what Pro/ENGINEER displays or hides 
within the Model Tree. For Pro/ENGINEER to find these configuration files, you must 
specify their location in the config.pro file. 

hole_sizes 
With Pro/ENGINEER, you can insert standard holes, that is, M10 tapped hole with a 
countersink. Pro/ENGINEER comes with a set of ISO, UNC, and UNF tables of hole 
sizes. An ISO coarse table contains the most commonly used ISO hole sizes. You must 
set the config.pro option of hole_parameter_file_path with the 
ISO_coarse.hol file to point at your centrally located pro_standards directory. 
Otherwise, Pro/ENGINEER does not find the file.  

material_database 
With solid modeling in Pro/ENGINEER, you can represent parts and assemblies as 
real solid components with accurate Mass properties. You can assign a diverse range of 
material properties to each solid part. Pro/ENGINEER comes with a sample set of 
materials that are in the directory <loadpoint>\ProENGINEER Schools 
Edition\text\materials-library. You can also define additional materials and 
store them in this central directory. 

You can provide student access a common material library. Copy the contents of this 
directory into the centrally accessible pro_standards\material_database 
directory. 
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To find the pro_standards\material_database directory, set the config.pro 
option of pro_material_dir to point at your centrally located 
pro_standards\material_database directory. 

part_libraries  
As part of best practice, use standard parts. For example, an assembly can contain a 
number of nuts and bolts. Rather than have students create their own models of a nut 
or bolt, you can have them use standard sets of nuts and bolts. Sample part libraries 
for nuts, screws, and commonly used batteries come with the software. 

To find the part_libraries directory, you must add the full path names of each 
directory to the search_path.pro file. For classroom installations, place this 
directory on a central server. 

templates 
For use in classrooms, place the template directory on a central server. When creating 
a new part, assembly, or drawing, Pro/ENGINEER uses templates, or start parts. 
These templates have predefined units, drawing borders, and so forth. Pro/ENGINEER 
comes with a default set of Imperial start parts and drawing formats. A metric set of 
sample start parts and drawing formats is also available. 

To include these template files in the Pro/ENGINEER user interface, you must set the 
relevant configuration options in the config.pro file with the path to the 
pro_standards\templates directory.  

start_model_dir 
template_solidpart 
template_designasm 
template_drawing 

trail_files  
Every time you starts a session of Pro/ENGINEER, a trail file is created. This trail file 
records all actions during that session. These trial files accumulate, and you must 
delete them. To make the deletion easier, follow these steps: 

1. Create a trail_files directory within each user account.  

2. Set the configuration option to direct Pro/ENGINEER to create the user-specific 
trail files in the appropriate user-specific directory. 

3. Set a trail_dir configuration option in the config.pro file to point at the users 
own trail_files directory. 

Managing Files and Your Work Environment 
You can manage your files and work environment in a number of ways.  

Using Pro/ENGINEER File Types 
The most widely used file extensions in Pro/ENGINEER are as follows: 

.prt—part files 

.asm—assembly 

.drw—drawing 

.frm—drawing format 
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Naming Files 
A name of a file, feature, drawing view, datum plane, sketch, or any file within 
Pro/ENGINEER cannot contain any of the following characters: & / . , ; : # % $ ( ). In 
addition, you cannot use a space in a file name, as in top bracket.prt. Use an 
underscore (_) instead as in top_bracket.prt. 

Pro/ENGINEER does not differentiate between uppercase of lowercase characters. For 
example, when opening a new part, you enter the file name Front_Wheel.prt. 
Pro/ENGINEER sees and refers to this part as FRONT_WHEEL.PRT, and on disk this 
part is seen as front_wheel.prt. 

Erasing Pro/ENGINEER Files 
Pro/ENGINEER holds the part, assembly, or other file in memory after you save and 
close it. Erase files from memory when you have finished with them. To remove a file 
from memory, click File > Erase > Not Displayed and choose the file to erase. 
Otherwise, when you open a file, Pro/ENGINEER first searches for it in memory and 
could open an unwanted file, as the example below explains.  

Suppose that you open wheel.prt from C:/my documents/projects/car and then 
close it. Next, you change directory to C:/my documents/projects/truck and 
select a file call wheel.prt from this directory. Pro/ENGINEER looks first in memory, 
sees a file called wheel.prt, and opens that file. As a result, the wheel.prt of the car 
would open and not the wheel.prt of the truck.  

Working with Versioned Pro/ENGINEER Files 
Every time you save a file in Pro/ENGINEER, a sequential version of the file is 
created. For example; if you open a newly created part called antenna.prt and save 
it, antenna.prt.1 is created, and then antenna.prt.2 and so on with each 
successive save. These versioned files can consume disk space. Purge files on a 
frequent basis on each directory with part files, assembly files, and drawing file.  

To add the Purge utility to the Windows Explorer menu, follow these steps:  

1. Open Windows Explorer. 

2. Click Tools > Folder Options and click the File Types tab. 

3. In the File Types list, click Folder and then click Advanced. The Edit File 
Type dialog box opens. 

4. Click New. 

5. In the Action box, type the name for the command, for example, ProePurge. 

6. Browse to the bin directory in the Pro/ENGINEER loadpoint directory and click 
purge.bat.  

7. In the Application used to perform action text box, at the end of the command 
type a space and then *.*. For example, …bin\purge.bat *.*  

 

The ProePurge command now appears on the shortcut menu. Right-click a folder and 
choose ProePurge to remove all old version files from this folder. 
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Troubleshooting 
Common questions and answers can help you get up and running with your 
Pro/ENGINEER Schools Edition. For additional troubleshooting assistance, see the 
Troubleshooting FAQ for the PTC Education Programs on the Schools Program page. 

Setup did not begin when I inserted the CD. What do I do? 
If PTC.Setup does not begin automatically, follow these steps: 

1. Click Start > Run on the Windows task bar. The Run dialog box opens. 

2. Click Browse. The Browse dialog box opens. 

 

3. For the Look in list box, click the down-arrow and select your CD-ROM drive. 

4. Click LAUNCH.EXE in the File name box. 

5. Click Open in the Browse dialog box. After the path appears in the Run dialog 
box, click OK. The Schools Edition starting screen appears. 

How do I locate my computer’s Host ID?  
The Pro/ENGINEER Schools Edition license is locked to the Host ID, which is the 
network physical address of your computer. You can find out your Host ID during 
installation or from the Start menu.  

During Installation 
The Host ID appears in the bottom-left corner of the first screen during 
Pro/ENGINEER installation.  

1. Insert your Pro/ENGINEER Schools Edition CD-ROM in to the CD-ROM drive of 
the computer on which you want to install Pro/ENGINEER.  
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2. Start PTC.Setup as described in the section Installing PRO/ENGINEER Schools 
Edition.  

3. On the first installation screen, in the lower-left corner, you will see a 12-digit 
number on the second line similar to that in the figure below.  

 

The 12-digit number with hyphens is your Host ID. 

From the Start Menu 
The Host ID appears when you enter the ipconfig/all command from a DOS 
window. 

1. Click Start > Run, type cmd, and press ENTER.)  

2. At the prompt, type ipconfig/all and press ENTER. The Windows IP 
Configuration information appears. 

3. Locate the line with the words Physical Address. The 12-digit number with 
hyphens is your Host ID. 

Physical Address. . . . . . . . . : 00-11-22-33-44-55 

What does the error in plpfhost mean?  
A plpfhost error can occur for one of two reasons: 

• A required Ethernet network adapter is not installed or configured properly. See 
your hardware vendor for installation and configuration information. 

• Media Sense within Windows 2000 causes the PTC Host ID (Ethernet network 
adapter address) to not be detected. It disables the network card. Use the 
instructions in the Windows 2000 document Q239924 to disable media sensing. 

Why does my Schools Edition not start? 
If your computer was upgraded from Windows 95/98/Me to Windows 2000/XP, the 
variable winbootdir could have been preserved rather than deleted. Delete the 
winbootdir variable and your Pro/ENGINEER Schools Edition will start. 

How do I disable Media Sense for TCP/IP in Windows 2000? 
To disable Media Sense for TCP/IP in Widown 2000, see the article from Microsoft: 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q239924 

What does the message “Could not detect network adapter” mean? 
See your hardware vendor for information on installing and configuring the 
network adapter if you get this message: Could not detect network adapter. 
An Ethernet network adapter is required to start the Pro/ENGINEER Schools 
Edition. 

http:///
http://support.microsoft.com/default.aspx?scid=kb;EN-US;q239924
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Why does Pro/ENGINEER not find the load point at startup? 
If you get the message Cannot Find <Loadpoint>\i486_nt\filename, the PATH 
environment variable for the Pro/ENGINEER load point is either is not set or is 
incorrect. You may have a syntax or spelling error. To correct this, follow these steps: 

1. Click Start > Settings > Control Panel. (For Windows XP, click Start > Control 
Panel). The Control Panel appears. 

2. Double-click System. (XP users, if you do not see System in the Control Panel, 
click Switch to Classic View in the upper-right corner.) 

3. Click the Advanced tab and click Environment Variables. The Environment 
Variables page appears. 

4. Look under System variables for the variable PATH. Check to see if PATH 
contains <loadpoint>\bin. (All values are separated by a semicolon. Therefore, 
if there are other paths before and after Pro/ENGINEER, the Pro/ENGINEER path 
will have semicolons both before and it). 

Note: The load point is the directory into which Pro/ENGINEER was installed. If 
you accepted the default location, then your load point will be C:\Program 
Files\ProENGINEER Schools Edition. If you installed Pro/ENGINEER into a 
directory other than the default load point, you must reflect that change. 

5. Between the semicolons, fix the PATH variable to the correct location of your load 
point. 

Why does my computer select a wrong network connection?  
If your computer automatically selects the wrong network connection, for example, 
WiFi instead of your preferred land-line connection, your computer is most likely using 
Media Sensing. Consider disabling Media Sensing. For information on how Media 
Sensing works and how to disable it, see the following link:  

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q239924. 

Note: Ethernet cable 10b2 or coaxial cable RG-58 is not a connection-based media. 
Windows does not attempt to detect a connect state if this type of cabling is used. Also, 
NetBEUI and IPX do not recognize Media Sense. 

Examples of some side effects exist for disabling the Media Sensing feature follow.  

• Your computer has two network adapters ,and the Media Sensing feature is 
enabled. If one network adapter does not work, it is unbound, and associated routes 
are removed. As a result, all traffic goes through the other network adapter, 
assuming a default gateway is there.  

• You are a roaming (portable) user. With the Media Sensing feature, you can 
connect to any network and have everything work, without restarting, releasing 
and renewing, and so on. After disabling Media Sensing and restarting your 
computer, Windows still shows the Network Disconnected icon on the task bar. In 
addition, the ipconfig command still shows a Media State .....: Cable 
Disconnected message when the cable is disconnected. However, the Network 
Interface is bound to TCP/IP. You can verify this by looking at the route table. Use 
the route print command to show the interface IP address. (You can also use the 
ping command to get the IP address assigned to the NIC). 

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q239924
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Why is the wrong Host ID displayed on Windows 2000?  
The wrong Host ID is displayed when a Windows 2000 computer is not physically 
connected to the network. The Ptcstatus utility shows the license server up with 
available licenses before Pro/ENGINEER is started. As a result, a Pro/ENGINEER 
licensing error occurs. Ptcstatus displays COUNTED after attempt to run 
Pro/ENGINEER. 

Ptclmgrd.log shows the wrong \Host ID. When a machine is booted off the 
network, the registry shows the network cards in an incorrect order at the following 
path: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\NetworkCards 

When you connect to the network, the order of the cards is correct when the network 
card that goes with the generated FLEXnet license is in the first folder. When you are 
disconnected from the network, the network card folders must be put in the correct 
order.  

This issue is related to the Media Sensing feature of Windows 2000. Disabling the 
Media Sensing resolves the issue. For more information on Media Sensing, see 
http://support.microsoft.com/support/kb/articles/Q239/9/24.ASP.  

 

http://support.microsoft.com/support/kb/articles/Q239/9/24.ASP
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